Working with Tables, Pictures

and Mail Merge

Introduction

This chapter expands on your basic LibreOffice Writer skills by focusing on tables. We will learn
how to create, position, and resize tables, as well as how to add, modify, and format data within them
using built-in styles.

Beyond tables, we will also discover how to insert and manipulate pictures in our documents. We
will explore the process of printing documents. Finally, we will master Mail Merge, a powerful
Writer feature for creating documents for multiple recipients.

Creating a Table

In word processing software such as LibreOffice Writer, a table is a structured grid designed to
organize information. It is made up of rows, which run horizontally, and columns, which run
vertically. The point where a row and a column intersect is called a cell, and each cell is where we
place a specific piece of data relevant to both its row and column. A sample table is shown below:

Student Data
Gr.No. | Name of Student | Class | Medium | Gender A Date of Birth
123 Kavya Patel 5 Gujarati F 5-9-2015
234 Ilias Mansuri 10 English M 7-7-2010
345 Blessy George 7 Gujarati F 6-12-2013
456 Kartar Sing 8 Hindi M 1-7-2012
567 Prapti Shah 5 English F 24-6-2015

Table 8.1 : A table with Sample Data

For certain types of information, a tabular format is much better than simply presenting data in
paragraphs for the following reasons:

° Tables offer a clearer visual structure, making it easier for users to scan and quickly find
specific data.

° Tables make complex data more manageable and understandable by breaking it down
into organized rows and columns.

e  Tablesletus presentdata concisely.
° Tables give us a better view when we need to compare data.
° Consistent formatting in tables boosts readability and helps prevent mistakes.

Now, let us create Table 8.1, consisting of 7 rows and 6 columns, to a new Writer document. Follow
the steps:

° Open anew (blank) document in Writer.
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We can insert a table by clicking the 7ab/e menu and then selecting Table from the Insert

submenu. This will open the Insert Table dialog box. We can also find the 7able option

directly in the /nsert menu.

° Enter 'SchoolTable' as the table label, with 6 columns and 7 rows as shown in figure 8.1.

. Insert Table
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Help

General

Label ;SchoolTable
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Repeat Heading Rows on new pages
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AutoFormat
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Figure 8.1 : Inserting Table in Document

° Once we have set the table's name, columns, and rows, click the /nsert button to add the

table to our document. Now we can populate it with the data as presented in Table 8.1.
Our table will then appear similar to the example shown in figure 8.2.
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Figure 8.2 : Inserting Data in Table
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Now, we will format the table to improve its look.
° Merge the cells in the first row by selecting them and choosing Merge Cells from the Table
menu.
° Select the first two rows, apply center alignment, and bold the text using C#r/ + B or the
toolbar.
° To better arrange the data, resize the columns by dragging the double-headed arrow that

appears when you hover between columns. We can also adjust row height similarly. The
formatted table is shown in figure 8.3.
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Student Data
Gre No.| Name of Student | Class | Medium | Gender | Date of Birth
123 | Kavya Patel 5 | Gujarat F 5-9-2015
234 | lias Mansuri 10 | English M 7-7-2010
345 | Blessy Geomne T Gujarati F 6-12-2013
456 |Kanar Sing a Hindi M 1-7-2012
567 | Prapii Shah 5 | English F 24-6-2015
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Figure 8.3 : Text Formation in Table
Operations on Table

Let us explore more table manipulation options by creating another table. Set up a new document in
Writer and create a table specifically for teacher information, like the one shown in figure 8.4.

B-aldda TEHE S 'S = a--d4e%18
B [V e e e P I R . B BN

Tracher Code | Toascher Name subject Dhate ol Suin e than .
o Saumya Shah Sumbt | 05062019 | Primary
Toaz Er—— Matesatics | 1210227 | Secoedlary |
To0nd Moharmmad Aaril Camspuiry OB06-2071 By rnwlary
Tl [Sapal Baggs | Socil Schene | _onan917 | rimary |
Toos Tony Biigesss | Musle | (110-2000 | Primary |

Pagr 1 == =l B § i i = m - P

Figure 8.4 : Table for Teachers
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Selecting Row/Column

To format or delete content within a table, we must first select the cells. The conventional way to
select neighbouring cells in a table is by dragging your mouse. Often, we will need to work with the
content of an entire row or column. Fortunately, LibreOffice Writer offers more efficient methods for

selecting an entire row or column.

° Move the mouse pointer to the immediate left of the desired row. When our mouse
pointer transforms into a small black right arrow, simply click to select the entire table
TOW.

° Similarly, to select an entire table column, position the mouse pointer directly above the

desired column. It will transform into a small black downward-pointing arrow. Simply
click to select the entire column.

We can also select specific parts of a table—a row, column, cell, or the entire table—by using the
menu options. Navigate to the 7Tuble menu, then choose the Select submenu. Within this submenu, we
will find four options: Table, Rows, Columns, and Cell.

Here is what each option does:

° Table: Selects the entire table.

° Rows: Selects the row where our pointer is located.

° Columns: Selects the column where our pointer is located.

) Cell: Selects the individual cell where our pointer is located.

We can also select arow or column by right-clicking on the table to open the context menu as shown
in figure 8.5. From there, hover over either the Row or Column submenu, and then choose the Select
option to select the current row or column, respectively.
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Figure 8.5 : Selecting Row Using Context Menu
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Inserting Rows, Columns and Tables

After setting up our table, we will (- Nt E RO A
often need to add more rows or

columns. Writer makes it easy to
. . - Insert
insert them into our existing table.
Here is how we can insert a new row: N umber |1 =
° To insert a new row, first,
place the cursor in the | position
table where we want the
row to appear. Then, go @ Before
to the Table menu, select Y After
Insert, and choose the
Rows... option. oK J Cancel H Elp
° Alternatively, we can

right-click on the table.

Figure 8.6 : Insert Rows Dialog Box

From the context menu that appears, hover over the Row submenu, and then select the
Insert... option.

Any of'above action will open Insert Rows dialog box as shown in figure 8.6.

° Once the Insert Rows dialog box appears, specify the desired number of rows in the
Number field. Then, choose whether we want to insert these new rows Before or After the
current cursor position.

) After we have set our preferences, click the OK button. The new rows will then be
inserted into our table. 3 -

X Insert Columns
Similarly, we can insert a new
column into our existing table by | Insert
following the same steps. Namber '1 -

° To insert a new column,
first place the cursor in Position
the table where we
would like the column to @ Before
appear. Then, go to the Y After
Table menu, select
Insert, and choose the OK J Cancel Help
Columns... option.

° Alternatively, we can

Figure 8.7 : Insert Columns Dialog Box

right-click on the table, then hover over the Column submenu and select the Insert...
option.(Refer figure 8.5). Either of these actions will open the Insert Columns dialog box
as shown in figure 8.7.
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In the Number box, enter how many columns we want to add. Then, choose whether we

[ ]
would like them inserted Before or After the current column position.

° After we have made our selections, click the OK button. The new columns will then be
added to our table.

° We have successfully inserted two rows and one column into our Teachers table. It

should now look like a table shown in figure 8.8.
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Figure 8.8 : Table with new Data in Inserted Rows and Columns

Inserting a table within an existing table, often called a nested table, allows for more complex and
organized data arrangements. Here is how we can insert a new table inside an existing teacher's table:

° Place the cursor inside the cell where we want the new table to appear.

° Go to the Table menu, select Insert, and then choose Table to open the Insert Table
dialog box.

° Choose the desired number of rows and columns, then click OK.

° Enter the data into the newly added table.

The figure 8.9 illustrates a nested table:
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Teacher Code| Teacher Name Subject Date of Section
Jain
TOO1 Saumya Shah Samskrit 05-06-2019 | Primary
TO02 Vikrant Patel Mathematics 12-10-2022 | Secondary
TOLD Faruk Shaikh English 06-03-2023 | Seconday
ToO3 Mohammad Aarif Computer 08-06-2021 | Secomdary
ToO4 Sawpal Bagga Social Sclence 09-09-2017 | Primary
ToOS Tony Brigenza Music 11-10-2020 | Primary/
Primary Secondary Secondary
Vocal Instrumental
Pagm i 1 i 11 Fraf st Bl Frggupk fraka - oo T [T
Figure 8.9 : Nested Table
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Deleting Rows, Columns and Tables

We can easily remove unneeded tables from the document. To delete an entire table, go to the Table
menu, select the Delete submenu, and then choose the 7able option. This action will permanently
remove the entire table and all its data from our document. If our cursor is currently inside a nested
table, only that nested table will be removed, not the main, outer table.

To remove specific rows or columns from the table, we have two simple methods.

Go to the 7able menu, then choose the Delete submenu. From there, we can select either
the Rows or Columns option.

For a quicker approach, right-click on any cell within the row or column we want to
delete. A context menu will appear; hover over the Delete option, and then choose either
Row or Column from the submenu.

The selected rows or columns will be promptly removed from the table.

Merging Cells

Often, we want to merge several cells to enter common data that applies to specific rows or columns.
Writer has a feature to merge the cells. Here is how it works:

Open the document that contains teacher's table.

Place the cursor in the first row of the table. Then, go to the 7able menu, select the Insert
submenu, and choose Row. This will insert a blank row with six cells at the top of the
table.

In the leftmost cell of this new row, type: Teacher's Data.

Select the entire first row. We can do this by going to the 7Table menu, choosing the Select
submenu, and then picking Rows. Once the row is selected, go back to the 7Table menu
and choose Merge Cells. Alternatively, we can right-click on the selected cells and
choose the Merge option from the Cel/l submenu.

All the cells in that first row will now merge into a single cell.

The figure 8.10 displays a teacher's table that includes merged cells.
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Figure 8.10 :Adding Title of Table by Merging Cells
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Splitting Cells

We can also divide any cell in a table into multiple smaller cells. To do this, simply select the cell we
wish to divide, then choose the Split Cells option from the 7able menu. This will open the Split Cells
dialog box as shown in figure 8.11.
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Into equal proportions
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Cancel

Help

In the Split Cells dialog box:
° Enter the number of cells we wish to divide the selected cell into.

) In the Direction section:

o Select Horizontally if we want to split the cell into multiple rows.

) Select Vertically if we want to split the cell into multiple columns.

° Click OK to complete the action.

The cell will then be divided into the desired number of rows or columns. For example, the figure
8.12 shows the fifth row after being split into two columns.

Figure 8.11 : Splitting Cell
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Figure 8.12 : A Row with Split Cell
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Adjusting size of Rows and - Column Width
Columns

We already know how to resize columns Wwidth oK

: Column P
need to be precise, or want to change the Cancel

width 4.00cm

exact same dimensions, we can use the H elp
menu options for precise adjustments.

and rows by dragging the mouse. But if we

4

size of multiple rows or columns to the

L

To precisely adjust column width, follow
these steps: Figure 8.13 : Changning Column Width
° From the 7able menu, go to the Autofit submenu and choose Column Width.... This will
open the Column Width dialog box as shown in figure 8.13.
) In the Column box, select the column number we want to adjust.
° Specity the desired width in the Width box. We can use the up and down arrows to fine-
tune the size.
° Click OK to apply the changes.
Here is how to adjust the height of rows:
) Select the rows we want to resize.
° Go to the Table menu, choose Autofit, and then click on Row Height.... This will open
the Row Height dialog box as shown in figure 8.14.

r

¥ Row Height

Height
{ QK J
b.01cm :
Cancel
M Fittosize
Help

Figure 8.14 : Changning Row Height

° In the Height box, enter number or use the up and down arrows to select the desired
height for the rows.
e Click OK.

Autoformatting the Table

Writer makes it simple to format the tables quickly and effectively using the AutoFormat option.
Here's how to apply an autoformat to the existing table:
) Open the document containing the table we want to format.
° Go to the Table menu and select AutoFormat. This will open the AutoFormat dialog box
as shown in figure 8.15.
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E AutoFormat

Format

Default : .

3D
Blue
Brown

Lavender
Yellow

Gray
Green

Red
Black 1

Black 2 —

Formatting
Number format Font Alignment

Borders Pattern

. OK .
Cancel
Help
Add
Delete

Rename

Figure 8.15 : AutoFormat Table

° Choose a pre-defined style from the Format selection list.

We can also fine-tune which formatting elements Writer applies by checking or
unchecking the Formatting checkboxes.(If our table contains text, make sure to uncheck
Number format to prevent our text from being incorrectly formatted as numbers.)

° Click OK to apply the chosen format.
The figure 8.16 shows a table after AutoFormat has been applied.
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5  Gujamti F 5-9-2015
10 English M 7-7-2010
7 Gujanti F 6-12-2013
B Hndl M 1-7-2012
5 English F 24-6-2015
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Figure 8.16 : A Table after Applying AutoFormat
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Inserting Picture

Pictures are not just decorative; they are vital tools for making a document more effective. They
transform plain text into a captivating experience, making information more engaging, easier to

grasp, and ultimately, more memorable for the reader.

Pictures serve as powerful visual explanations. They can instantly clarify complex concepts,
communicating ideas that would otherwise require lengthy descriptions. Beyond their ability to
enhance understanding, images are excellent attention-grabbers, effectively drawing the reader's

eye into our content.
Letus learn how to insert an image into Writer document. Follow these steps:

) Open a new document in Writer, or simply place the cursor in an existing document

where we wish to insert the picture.

° Go to the Insert menu, then the Picture submenu, and select From File.... This will open
the Insert Picture dialog box as shown in figure 8.17, showing a list of images saved on

our system. We can then browse other folders to find the picture we want.

D Insert picture

+ 4 | s sakelsir | Pictures

Location: |Rose0&7.jpg

Places Name * Size Modified = Rose067.jpg
Q search L Pagesetupbac... 33.1kB 01:13
O Recently Used Pagesetup bac... 67.8kB 01:14
& saketsir = Pagesetup bac... 483kB 01:14
B Desktop ~ Pagesetup bac... 18.3kB 01:10
— File System " Pagesetup for... S56.0kB 01:09
[ Floppy Disk " Property.png 31.1kB  09:19
£ 42 68 Volume _Rose067pg  112.2kB Monday 08 February 1999
L 42 GB volume Select column,... 128.7kB 04:22
4 Documents “ slide-4.png 209.1kB 01:27
& Music = Slide-2.png 257.6kB Sunday 01 June 2025
8 Pictures = Slide-3.png 555.6 kB Sunday 01 June 2025
B videos Slide-5.png 280.2 kB 01:39
4 Downloads Stars.png 1349 kB 00:25
<All formats>
* File type
Style: Graphics -
B Preview
Link
Cancel | B CpeEn
Figure 8.17 : Insert Picture Dialog Box
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° Simply select the picture file we want to use and click Open. The image will then be
inserted into our document with its original dimensions as shown in figure 8.18.
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Figure 8.18 : Picture Inserted in Document

) Once our picture is in the document, we will see edit points (tiny green squares) around
its border. We can drag any of these points to resize the picture. To keep the image from
looking stretched or squished, hold down the Shift key while dragging.

) To move the picture, simply drag it to the desired
location in the document.

° When we select a picture, the Picture toolbar will
pop up at the top of the Writer interface. This
toolbar gives us quick access to features like text
wrapping, image alignment, borders, and precise
positioning.

° We can also use the Drawing toolbar to add basic
shapes, text boxes, callouts, arrows, stars, and

even "fontwork" (stylized text). We will dive
deeper into the Drawing toolbar in Chapter 10.

. . ) . . Figure 8.19 : Context Menu
Furthermore, right-clicking on the picture will bring up a and Options for Picture

context menu with even more options for manipulating the image, as shown in the figure 8.19.

Printing a Document

So far, we have been creating documents meant for viewing on a screen. But what if we need to
access document even after closing Writer or shutting down computer? For that, we will want to
print the document onto paper, commonly known as a hard copy.

LibreOffice Writer offers a wide array of printing options for documents. Steps to print a document
are as follows:
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° Open the document we wish to print in Writer. Make sure to format it exactly as we want
before proceeding.

° Go to the File menu and select the Print option. Alternatively, we can simply press Ctr/
+ Pto open the Print dialog box as shown in figure 8.20.

General LibreOffice Writer Page Layout Options
Printer

210mm (Ad)

E » Details Properties...
P
o Range and coples
@® Allpages Mumber of copies [l
P
ek Collate :1‘.!. ;ﬁ.!;
Selection e

Print jn reverse page order
Print

Comments MNone(document only)

1 /1

oK || Cancel Help

Figure : 8.20 : Printing the Document

On the left side of the Print dialog box, we will see a preview of the document exactly as it will
appear when printed.

° In the General tab of the Print dialog box, we will find several options to customize the
printing:
o Printer: Choose the specific printer we want to use for the document from this
dropdown list.

o  Properties...: Click this button to access the settings for our selected printer, such
as paper size and orientation.

o Range and Copies:
m  Allpages: Select this to print every page of our document.
m  Pages: [fwe only need specific pages, enter their numbers here.

m  Selection: This option will print only the data we have highlighted in our
document.

o Print in reverse page order: Check this box if we want our document to print
from the last page to the first.

o Number of copies: Enter the desired number of copies we want to print.
o Collate:
= Enabled: The printer will print one complete set of our document.

= Disabled: The printer will print all requested copies of the first page, then all
copies of the second page, and so on.
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° Once we have made the selections, click the OK button to begin printing. Before we do,
double-check that the printer is connected to the computer, powered on, and has paper
loaded in its feeder tray.

Mail Merge

Mail merge is a fantastic feature in LibreOffice Writer that lets you create personalized documents
for many people with ease. Instead of typing each document manually, mail merge automates the
process by combining a single template document with a data source.

The key components of Mail Merge are explained below:

° Main Document: This is the template document that holds the content common to all
recipients.

e  DataSource: This s the file, holding unique information for each recipient.

e  Merge Fields: These are special placeholders we insert into the main document. Each
one links up with a specific column in the data source.

Let us walk through an example to understand the Mail Merge feature. Let us say we are planning to
invite five friends to the birthday party. The usual way would be to type out one invitation, then copy
it four more times, and finally, manually add each friend's address to their respective copy. This
whole process can be much simpler and more organized if we use the Mail Merge feature.

Now, let us create the first component of Mail Merge. Type the following invitation letter format into
anew Writer document.

Sheel Bhatt
2/5,XYZ Apartment,
Paldi, Ahmedabad-380007

Date: 03-11-2025

To,
Dear,

Getready to celebrate! My birthday is just around the corner,
and I would love for you to join me for a party to mark the
occasion. It is going to be at my place on 10" November at
6pm. We will have a good music, delicious food and fun
games. Your presence would mean a lot to me.

Lovingly yours,

Sheel Bhatt

Save the document as 'Invitation Letter'.To begin the Mail Merge process, open the 7ools menu and
select the Mail Merge Wizard option. This action will launch the Mail Merge Wizard dialog box,
which guides us through five distinct steps. Each step is clearly outlined in the left-hand pane, while
the corresponding options for that step are presented in the right-hand section.
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Step-1 : Select Starting Document

This is the very first step, where we tell the wizard which document we want to use as the main

document for our mail merge. We have four main options here as shown in figure 8.21.

Mail Merge Wizard

Stepn Select Starting Doacument for the Mail Merge
© Use the current document

1.5elect Starting Document Exchange Databases..
£ Select Document Type
1 Insert Address Block

(L) Create a new document
() Start from existing document

4 Create Sslutation
Browse...
2 Adust Layout
() Start from a temiplate
Browse...
Start from a recently saved slarting document

Cancel

Figure 8.21 : Select Starting Document

° Use the current document: This means we will use the LibreOffice Writer document that

we currently have opened.

e  Create a new document: A new, blank document will open. This is where we will compose

the main content of our mail merge document.

e  Start from existing document:This option allows us to browse and select any other existing

LibreOffice Writer document on our computer to use as the main document for our mail

merge.

e  Startfrom atemplate:If we have a pre-designed template saved in LibreOffice Writer, we can

choose this option to start with that template.

Since we have already drafted the invitation letter in our current document, simply select Use the

current document and then click Next. The Mail Merge Wizard's second step will now appear.
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Step-2 : Select Document Type

Get More Learning Materials Here :

Mail Merge Wizard X

Steps What Type of Document Do You Want to Create?
O Letter

1. Select Starting Document (@] Ernail message

D o Tt an b peiomaon for s gt

3. Insert Address Block

4. Create Salutation

5 Aclpust Layout

Figure 8.22 : Select Document Type

In this step, we have to determine the final output format and some of the subsequent options we will
encounter in the wizard. We will have two options here as shown in figure 8.22:

[ ]
standard letter.

Letter: Select this option to create multiple personalized documents, each resembling a

E-mail: Select this option if we wish to send our merged document as email message.

Select Letter option here and click Next. The Mail Merge Wizard's third step will now appear.

Step-3 : Insert Address Block
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Figure 8.23 : Insert Address Block
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Now, it is time to add the addresses of our friends who will receive the invitation. Click the Select
Addpress List... button shown in figure 8.23 to open the Select Address List dialog box shown in figure
8.24. This is where we will set up the structure for our addresses. To create a new list, simply click the
Create button, and the New Address List dialog box will appear as shown in figure 8.24.
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Figure 8.24 : Opening Select Address List and Creating New Address List

In the New Address List window, we can immediately begin entering our friends' addresses. If we
need to tailor the address structure to our specific needs, simply click the Customize... button. This
will open the Customize Address List dialog box, allowing us to modify the fields. We have full
control over our address fields: click Add to introduce new ones, Delete to remove any we do not
need, and Rename to change the name of an existing field. The figure 8.25 illustrates our chosen final

list of address fields.
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Figure 8.25 : Customizing Address Fields

Enter the address for our first friend, then click the New button to add another. Repeat this
process for all five friends, and once we are done, click OK. Give the address file a name, then
click OK to save the data source. Click OK in the Select Address List dialog box to confirm our
data source. We will then return to the Mail Merge Wizard. Check the box next to This document
shall contain an address block. To setup the address block, click the More... button to open the Select
Address Block dialog box as shown in figure 8.26. From there, click the Edit button, which will open
the Edit Address Block dialog box. In this dialog box, we can add, remove, or change the order of our
address fields.
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Figure 8.26 : Editing Address Block

Click OK when we finish editing the address block. A preview of the first address from our data
source will be displayed at the bottom of the Mail Merge Wizard dialog box as shown in figure 8.27.

Mail Merge Wizard
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Figure 8.27 : Selecting Address Block
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Click the Next button to accept the chosen address block. This will take us to the next step of the mail
merge wizard: Create Salutation as shown in figure 8.28.
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Figure 8.28 : Adding Salutation

Here, we can pick a salutation for our recipients. Since we don't want to use one, just click Next to go
to the final step of the Mail Merge wizard: Adjust Layout as shown in figure 8.29.

;mm X
Adjust Layout of Address Block and Salutation
Address Block Position
1. Select Starting Document Fromtop  560cm o
2 Sebect Document Type 8 Aign to text body T p—
3. Insert Address Block Fromleh 2%0em x gy
A Creste Salutation - :- —
b Aot Loyoot R == =
e
Meoee Eoam
o waly e
e i e e
Y e L
Ry e,
Zoom
Help < Back Next » Fuath Cancel
Figure 8.29 : Adjusting Layout of Address Block
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In this final step of the Mail Merge wizard, we can adjust the position of our address block in the main
document using the From top box. We can also zoom in to see the exact placement of our address
block within the document.

Click Finish to exit the wizard. We will now see the address block, complete with field names,
inserted into our main document as shown in figure 8.30.
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Figure 8.30 : Fields of Address Block Added in Main Document

To finalize the merge, simply click the Edit Individual Documents button in the Mail Merge toolbar.
This action will generate a new document where our main document is merged with all five friend
addresses. We can now save the merged document with any filename.

Summary

In this chapter, we gained comprehensive skills in organizing data in tabular form using rows and
columns. We learned to create and format tables effectively with LibreOffice Writer's features,
including various table operations like inserting, selecting, and deleting data, rows, and columns.
We also mastered merging and splitting cells, and adjusting row height and column width for
optimal table display. The AutoFormat feature was introduced as a quick way to style our tables.

Beyond tables, we enhanced our documents by inserting pictures, and learned to move and resize
them for proper arrangement. Finally, we discovered how to print our documents to obtain hard
copies and utilized Writer's powerful Mail Merge feature to generate multiple personalized copies of
adocument for different recipients.

EXERCISE
1.  What s a table and how does it store data?
2.  How can we insert a table with 5 rows and 10 columns?
3. What are the methods for selecting an entire row or column within a table?
4.  Define a nested table and explain how to create one.
5.  How do we delete unwanted rows, columns, or tables from a document?
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How do we merge cells within a table?
What is the AutoFormat feature in Writer?

What is the significance of including pictures in documents?

e ® A

Explain the process of printing a document.

10. What is Mail Merge and what are its advantages?
11. State whether True or False.

(1) Itis not possible to embed a table inside an existing table.
(2) We can insert a column to the right of an existing selected column.

(3) Intersection of row and column is known as table.
(4) We can find the AutoFormat option in the Tools menu.

(5) Whenweright-click on selected cells within a table, the context menu provides an option
to merge those cells.

12. Fill-in the blanks.
(1) Afileholding unique address for each recipient in Mail Merge is known as
2) can be used to format a table quickly and efficiently.
(3) Aprinted copy of document on paper is known as
4) feature is used to create personalized document for many recipients.
®)] is atemplate document in mail merge to hold common content.
13. Multi-choice questions. Choose the most correct answer.

(1)  Which tool helps manage and understand complex data by organizing it into rows and

columns?
(a) Image (b) Table (c) Mail Merge (d) Print
(2)  Which option in Print dialog box should be selected to print a selected block to data?
(a) Pages (b) AllPages
(c) Selection (d) Block
(3) Whatisthe term for the intersection of a row and a column?
(a) Table (b) AutoFormat (c) Cell (d) Nested table
(4)  Where can new rows be inserted into a table?
(a) Above the current row (b) Below the current row
(c) Atthe left of current column (d) Both A and B
(5) What is a table within another table called?
(a) Duplicate table (b) Promoted table (c) Dual table (d) Nested table
(6) What are the small green squares that appear around a selected picture known as?
(a) Ducks (b) Edit points
(c) Placeholders (d) Selection points
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(7)  Which toolbar in Writer allows us to insert basic shapes?

(a) Picture toolbar (b) Image toolbar (c¢) Diagram toolbar (d) Drawing toolbar
(8) What is the keyboard shortcut to open the Print dialog box?

(a) Cul+P (b) Alt+P (c) Ctrl + Alt+P  (d) Ctrl + Space + P
(9) What is a document printed on paper also known as?

(a) Chart copy (b) Hard copy (c) Soft copy (d) Duplicate copy
(10) Which feature is used to create personalized documents for many people with ease?

(a) Tables (b) AutoFormat (c) AutoMail (d) Mail Merge

Laboratory Exercise

1. Create a table for employees with following columns: Employee name, Department, Date of
Join, Date of Birth, Gender. Insert five records in table.

2.  Insert one row at the top of table. Merge all the cells of that row and insert heading: Employee

Data

3.  Inserta column between Date of Birth and Gender. Insert data about Salary of each employee
in this column.

4.  Adjustthe column and row sizes to enhance the table's appearance.

5. Apply AutoFormat to the table created in question 1.

6. Insert a relevant image within the document, positioning it alongside the employee table.
Ensure the image is appropriately resized for optimal visual presentation.

7.  As a shopkeeper selling electronic products, draft a Mail Merge letter to five customers
announcing a new product launch.

8.  Requestyour teacher to show how to print any document you have prepared.

J/
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